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Introduction
AutoPilot for Archer’s 64-bit architechture enables multi-site, PC-based facilities management for
Archer monitoring and control systems from Burk technology. Built-in reports are easily tailored to
individual needs, and can be printed automatically or emailed as PDF files.
AutoPilot for Archer's fully customizable interface makes managing remote sites easy for operators,
engineers and managers. The PTT Flipbook graphical display element makes it easy to examine current
and past push-to-talk events including forward power, reflected power and VSWR values.
With AutoPilot for Archer, you can:
•
•
•

Monitor and control multiple Archer sites in real-time.
Automatically print or email reports to station personnel.
Build custom screens to tailor the software to your exact needs.

Read the Getting Started section for help setting up AutoPilot for Archer for the first time. To get the
most out of the AutoPilot for Archer software, see the In Depth section. For detailed information about
specific topics, see the REFERENCE section.

Getting Started
Overview
Working with Docking Windows
Moving Docking Windows
The position of each toolbar can be changed by clicking on the title area and dragging it. The toolbars
can be undocked into a floating window, or docked to the top, bottom, and sides of the screen.
Dropping one toolbar on top of another combines the two into the same space, allowing selection of
one toolbar at a time with tabs. To separate tabbed toolbars, click and hold the tab and drag away from
the toolbar.
Auto Hide
Docking windows have an auto hide feature, allowing them to disappear from view when
unneeded to maximize the available screen space for monitoring and control.
To turn auto hide on or off, click the pushpin icon in the upper right of a toolbar’s title bar. A vertical
pushpin indicates that auto hide is off and the toolbar is locked into place until you move it or turn auto
hide on. A horizontal pushpin means auto hide is on. When you remove the mouse from the toolbar
area, the toolbar will collapse into a tab on the perimeter of the screen. To display the toolbar again,
simply move your mouse over the tab.
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Auto hide does not close the windows – they collapse into tabs on the sides or bottom (depending on
docked location) of the AutoPilot for Archer window. To have the window reappear, simply move your
mouse over the tab. This causes the window to expand, allowing you to use it. To hide the window
again, move the mouse away from the window and it will collapse after a few seconds.
When Auto Hide is enabled, clicking the window’s title area or icon tab will lock focus on the window,
and the toolbar will not hide again until you click a different area in the program to change focus.
Reset Docking Windows
The function key F10 is mapped to the reset windows that have been docked. This option is also in the
View menu of AutoPilot.
Resources
The Resources window is the main tool used for selecting items to work
with in AutoPilot for Archer. The Resources window shows your Archer
sites, Custom Views, and Reports.
To view an item, click on its icon. By default, Reports require a double-click
to open. You can change this behavior in the Options dialog.
Each item in the Resources window has a context menu, accessed by a
right-click that shows a list of actions that can be performed on that item.
By default, the Resources window is docked to the left hand side of the
screen. You can move, hide, or close the window to suit your needs.
New items (sites, custom views, or reports) are created in the Resources window. Once created, these
items are available to drag into the Navigator to group them into categorized views that you define, as
described in the next section. To completely delete an item, delete it from the Resources window.
Navigator
The Navigator lets you organize items from the Resources window into groups. Using a hierarchical
network view, similar to a Windows-style file system, you can create new folders and drag in sites,
custom views and reports from the Resources window wherever you like.
These groupings make it easy for you to view your data in a way that is meaningful to you. For example,
if you manage a state-wide network, you could create a folder for each county including that county’s
sites, reports and custom views. The county folders could be sub-folders in a state-wide folder that
includes a high level custom view based on a state map. The organization is entirely flexible.
Create as many views within the Navigator as you like. Multiple copies of sites, custom views and
reports can be displayed in the Navigator, giving you complete flexibility in displaying your assets. The
original, underlying data remains unchanged and is displayed in the Resources window.
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To completely delete an item, delete it from the Resources window. This will automatically remove all
instances of the item from the Navigator.
The Navigator starts out unpopulated.

Unpopulated Navigator

To create a network topology within the Navigator, add new folders and drag sites, custom views, and
reports from the Resources window. You can nest folders within folders to create hierarchies.
In this example, the folder ‘Sites’ contains all the site-related information while a second folder collects
custom views associated with channels.

Copies of Items Dragged from Resources Window to Navigator
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Resources Tool Tips
Tool tips are available for most Resources window and Navigator icons. Hover over an icon to see more
information about it.

Navigator Tool Tip

Default Views
AutoPilot for Archer can display a Default View for each site without any additional configuration. To
open a default view, click on the site's icon in the Resources window or Navigator. The Default View will
show all of the channels on the selected site, using the labels and colors configured for the site.
Opening Default Views with a single click can be disabled in the Options dialog. To open a default view
when this is the case, double-click on the site or right-click and select "Default View".
Default Views may also be opened in a new window by right-clicking on the site and selecting "Default
View in New Window".
Default View Display Modes
AutoPilot for Archer offers two types of default views: Graphical or Grid. To select a display mode, use
the drop-down in the Default View tool bar.

Display Mode Selector
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Graphical View
The Graphical View is the primary Default View. The Graphical View displays site data using realistic
analog gauges and LEDs

Archer Graphical View

Grid View
The Grid View displays all of the site's channels in a three-pane grid (metering, status, and commands).
Warning conditions are highlighted in yellow and critical conditions in red. This allows an operator to
quickly assess site conditions, and maximizes the amount of data that can be easily read on one page.

Grid View
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Custom Views Overview
Custom Views allow you to completely customize the look and feel of AutoPilot for Archer to suit your
needs. For more information about Creating Custom Views.
Custom Views offer a wide variety of onscreen components to display site data. Custom Views can
include any number of channels of any type, from multiple sites.
Popular uses of Custom Views include:
•
•
•
•

Interfaces specifically designed for operators, engineers, dispatchers, etc.
Summary screens showing high-level site data from multiple sites.
"Drill-down" interfaces allowing users to click on status indicators to learn more about alarm
conditions.
Map views to show status indicators on state or county, regional, or national maps,
corresponding with the location of the site.

To open a Custom View, click on the desired view in the Resources window or Navigator (Custom Views
appear in the "Custom Views" folder in the Resources window). Note that single-clicking to open a
Custom View can be disabled in the Options dialog. If this is the case, double-click on the Custom View
or right-click and select "Show View".
To open a Custom View in a new Window, right-click on the Custom View in the Resources or Navigator
window and select "Show View in New Window".
Note: You can open a Custom View outside of AutoPilot for Archer by double-clicking the Custom
View file in Windows.
Linking Sites to Custom Views
To use a Custom View instead of the Default View for a site, right-click on the site in the Resources
window or Navigator and select "Link Custom View". AutoPilot for Archer will prompt you for the
desired Custom View file. Once you have linked a site to a Custom View, clicking on the site in the
Resources window or Navigator will open the Custom View instead of the Default View.
To restore the default behavior, right-click on the site and select "Unlink Custom View".
Note: You can still access a Default View for a site when linked to a Custom View by right-clicking on
the site and selecting "Default View".
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Reports Overview
AutoPilot for Archer Reports all you to format and
print/display your logged data from one or more sites.
Reports can be viewed onscreen, printed to paper, or
saved as a PDF file. AutoPilot for Archer can
automatically print a report on a regular basis, as well
as automatically email a PDF of the report to one or
more email addresses.
A Report in AutoPilot for Archer is a template,
describing what data should be included and how it
should look. Whenever you run a report, AutoPilot for
Archer pulls the appropriate data from the database.
Once you have created your report, you can run it as
often as needed, and do not need to edit it to update
your data.
To learn how to create a report, read
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CREATING Reports .

Running Reports
To run a report, you can print it directly, or view a print preview (either in AutoPilot for Archer's main
window or in a new window). The print preview display also allows you to save to PDF.

"Save to PDF" from the Print Preview window

Note: AutoPilot for Archer requires that you have a default printer selected in Windows to run a
report - even if you are not printing to paper. If you do not have a printer installed, you can add a
printer to Windows even if one is not connected to your computer.
To print directly, select the Report in the Resources window or Navigator and select "Print..." from the
File menu.
To run a print preview, select the Report in the Resources window or Navigator and select "Print
Preview" from the File menu. You can also simply double-click on the Report in the Resources window
or Navigator.
To open a print preview in a new window, select the Report in the Resources window or Navigator and
select "Print Preview in New Window" from the File menu.
Note: If desired, you can set AutoPilot for Archer to automatically open a print preview when you
select a Report in the Resources window or Navigator. To enable this feature, access it from the
Options dialog.
Alarms Overview
Alarms are generated by the remote control and reported to AutoPilot for Archer. Any time an alarm is
received, AutoPilot for Archer logs the alarm to the database – even if logging is disabled.
Terminology
Active Alarm
Inactive Alarm
Incidental Alarm
Cleared Alarm
System Alarm
Duplicate Alarm

An alarm whose channel is presently still in an alarm state is active.
An alarm whose channel is no longer in an alarm state is inactive.
If an alarm does not have a state that will cause it to become inactive, it is an
incidental alarm.
An alarm can be cleared by a user running AutoPilot for Archer, or by
another source (such as a Web Interface user).
A system alarm is generated by the remote control to indicate an internal
error or problem.
An alarm is a duplicate if it has the same source channel as another alarm.
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Alarm Severity
Alarm Priority

Alarms are either warning or critical conditions. AutoPilot for Archer
displays the alarm severity, and uses it to color code alarms in Reports.
Alarm priority is a numeric value assigned to an alarm condition to help an
AutoPilot for Archer user determine which alarms are the most or least
important.

The Alarm List
The Alarm List displays all alarms on all currently connected sites. By default, the Alarm List is docked
on the bottom of the screen. This is the primary means by which AutoPilot for Archer displays alarm
information, and allows you to clear alarm conditions.

Alarm List
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Tool Bar Buttons
The Alarm List has its own tool bar, allowing you to clear one or more alarms and change how alarms
are displayed.
Clear All Alarms
Clear Selected Alarms
Show Cleared Alarms

Show Active Alarms Only
Show Duplicate Alarms

Clears every alarm in the Alarm List.
Clears the icon or icons that are current selected in the Alarm List.
When "Show Cleared Alarms" is enabled, the Alarm List will include
alarms that have already been cleared. Cleared alarms are show in
gray, italicized text.
When "Show Active Alarms Only" is enabled, the Alarm List will
only show "active" alarms.
When "Show Duplicate Alarms" is enabled, the Alarm List will show
every instance of an alarm. When not enabled, the Alarm List will
hide duplicate alarms, and display "More..." next to an alarm if
duplicates exist.

To display the Site Alarm list, right click on a site in either the Navigator or Resources pane.
Fields
Date/Time
The date and time (in the local time zone) when the alarm occurred.
Duration
For inactive alarms, the duration (hours, minutes, and seconds) for which the alarm
was active.
Network
The name of the Network in AutoPilot for Archer where this alarm occurred.
Site
The name of the Site where this alarm occurred.
Severity
The severity (warning or critical) of the alarm.
Priority
The priority of the alarm (1 – 255).
Alarm Type
Describes the source of the alarm (meter, status, system, user, etc).
Message
Describes the alarm condition.
Time Cleared
For cleared alarms, the date and time (in the local time zone) when the alarm was
cleared.

To clear alarms on a single site only, open the Site Alarms list. To sort alarms by one of the fields above,
click on the field in the list's header. Click again to sort in the opposite direction.
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Icons
The following icons are displayed in the Alarm List to describe the type and state of an alarm:
Active Alarm
New Active Alarm
Inactive Alarm
Incidental Alarm
New Incidental Alarm
Cleared Alarm

This alarm is active, not cleared, and occurred before AutoPilot for
Archer connected to the site.
This alarm is active, not cleared, and happed after AutoPilot for Archer
connected to the site.
This alarm is no longer active.
This is an incidental alarm that occurred before AutoPilot for Archer
connected to the site.
This is an incidental alarm that occurred after AutoPilot for Archer
connected to the site.
This alarm has been cleared with the Clear Alarm command and can no
longer become active.

Alarm Notifications
In addition to the Alarm List, AutoPilot for Archer can notify you of alarm conditions using the New
Alarm dialog, the New Alarm Desktop Alert, and sounds.

New Alarm Dialog

New Alarm Desktop Alert
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Events
The Archer includes an onboard Event List. The Event List displays site activity such as commands,
connections, etc.
Event List
The Event List in AutoPilot for Archer is, by default, displayed docked to the bottom of the screen in a
tabbed group with the Alarm List.

Event List

Fields
Date/Time
Network
Site
Event Type
Message

The date and time (in the local time zone) when the event occurred.
The name of the Network in AutoPilot for Archer where this event occurred.
The name of the Site where this event occurred.
Describes the source of the event (macro, command, error, etc).
Describes the event.

Adding Events
Archer supports user-generated events. To add an event to the Archer, right-click on the icon for the
desired site in the Resources window or Navigator and select "Add Event Message...". Enter a message
for the event and click OK.

Add Event Message Dialog
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Adding an Archer Network and Site
To add a new Archer network, click File -> New -> Archer Network... to bring up the Archer Network
Wizard.
Once the wizard is complete, your Archer Network (and its site) will appear in the Resources window.
To change your settings you can return to the wizard later by right-clicking a network in the Resources
window and choosing "Edit Archer Network...".
Archer Network Wizard
Welcome
Click "Next" to start the Wizard.

Network Name and Login
Enter a name to describe this Archer Network. The name will be
displayed through AutoPilot for Archer.
Enter your user name and password for this Network.
Enable Always prompt for password when connecting if you
want to disable an automatic connection to log.

Connection
Enter the hostname or IP address of the host.
Select the host port.
Select settings for SSL and automatic connection.
Connect automatically
When checked, AutoPilot for Archer will automatically connect
to this site on startup.
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Logging
If desired, AutoPilot for Archer can enable logging on the site.
Enable logging
Checking this box enables logging for the selected site(s).
Log every
This is the frequency, in minutes or hours, at which AutoPilot for
Archer will take its log.
Next log
This is the time of day when AutoPilot for Archer will take its first
log. AutoPilot for Archer will always add the logging interval to
the next log time to determine when it is time to log again. By
doing so, AutoPilot for Archer can keep to a regular "pattern" for
its log (such as every hour on the hour).
Finish
Click Finish to save your Archer Network and close the wizard.

Creating Custom Views
Custom Views allow you to tailor AutoPilot for Archer's interface to suit your operation's needs. You can
create Custom Views using built-in templates, or from scratch with the Custom View Editor.
Terminology
Custom View Control
Binding

Control Properties
Custom View
Template
Selection Handles

A Custom View Control is an onscreen element such as a graphical meter,
status LED, or command button.
Binding a Custom View Control to a remote control channel or other
parameter creates a link between that parameter's value or associated
action and the behavior of the control. Binding to a meter channel causes
the control to display the meter's value. Binding to a status condition
causes the control to display the status condition (on or off). Binding to a
command causes the control to execute that command when clicked.
A control's properties are attributes that define its appearance and
behavior, such as colors, limits, and labels.
A Custom View Template is a pre-defined Custom View that you can
associate with your site. You can edit the resulting Custom View to tailor it
to your specific needs.
Selection handles are squares that appear around a selected control.
Selection handles are used to indicate which control or controls are
selected, and to resize the control.

Custom View Editor Overview
The Custom View Editor allows you to create and edit Custom Views. To create a new Custom View,
open the Custom View Editor (File  New Custom View)
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The components of the editor are described below.
Canvas
The canvas is where you will arrange your Custom View controls. When you display your Custom View
in AutoPilot for Archer, only the canvas is shown.

Canvas

Grid
By default, the Custom View Editor displays grid dots on the canvas. The grid is useful for aligning and
positioning controls.
You can turn the grid on an off by clicking "Show Grid" from the View menu in the Custom View Editor.
Primary Control Selection
When more than one control is selected, one control is the primary control. Some actions in the Custom
View Editor only apply to the primary selection, or otherwise relate to it.
The primary control is indicated by normal selection handles (black, by default). Secondary selection
handles are shown using a reverse color scheme.

Multiple controls selected. The primary control is shown with black selection handles.
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Note: When displayed in AutoPilot for Archer, your Custom View will not show the grid.
Toolbox
The toolbox is a categorized list of all the Custom View controls available to you. Each control appears
in its associated category (Meters, Status, etc), as well as in the "All Items" category. To add a control to
the canvas, click and drag the control to the desired location. When you release the mouse button, the
Custom View Editor will add a new instance of the selected control to the canvas.

Toolbox

Properties
The properties grid displays and allows you to edit all of the properties for the selected control.
To change a property, select its value in the grid and replace it with the desired value. Some properties
use a pull down menu or popup dialog (indicated by a "..." button).
A description of each property appears at the bottom of the property grid when a property row is
selected.
Note: If more than one control is selected, the properties grid uses the primary control (see above).
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Properties

Undo History
The undo history list displays recently performed actions that you can undo (or redo). Double-clicking
on an item in the list will undo or redo that action.

Undo History
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Adding, Positioning and Sizing Controls
To add a control to the Custom View canvas, click and drag the control from the toolbox and drop it
onto the canvas.
To move a control already on the canvas, simply click and drag to reposition it.
To resize a control, select the control by clicking on it and use the grab handles to resize it. Controls can
be resized horizontally or vertically, or diagonally using the corner handles.
Snap to Grid
To make it easier to align and position controls, the Custom View Editor can force controls to conform
to the grid as they are moved and sized. This functionality is enabled by default, and can be toggled by
selecting "Snap to Grid" from the Format menu.
Positioning Controls on Top or Below Other Controls
Use "Send to Back" and "Bring to Front" from the Format menu to position controls above or below
other controls on the canvas.
Sizing and Aligning Controls Relative to Other Controls
The Custom View Editor has several tools that allow you to size and align controls relative to other
controls on the canvas. These are useful tools to help create Custom Views with a polished, professional
appearance.
To use these tools, select multiple components at once by using Ctrl+Click or clicking and dragging a
selection rectangle around the desired controls to activate the toolbar. The toolbar contains the
buttons described below.
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Align Lefts
Align Centers
Align Rights
Align Tops
Align Middles
Align Bottoms
Make Same Width
Make Same Height
Make Same Size
Make Horizontal Space Equal
Increase Horizontal Space
Decrease Horizontal Space
Remove Horizontal Space
Make Vertical Space Equal
Increase Vertical Space
Decrease Vertical Space
Remove Vertical Space
Center Horizontally in View
Center Vertically in View

Aligns all the controls on the left hand side.
Aligns all the controls in the center.
Aligns all the controls on the right hand side.
Aligns all the controls on the top.
Aligns all the controls in the middle.
Aligns all the controls on the bottom.
Sets all the controls to the same width.
Sets all the controls to the same height.
Sets all the controls to the same size.
Spaces all the controls so that horizontal spacing is equal
between each control.
Increases the horizontal spacing between each control.
Decreases the horizontal spacing between each control.
Removes all horizontal spacing between the controls.
Spaces all the controls so that vertical spacing is equal between
each control.
Increases the vertical spacing between each control.
Decreases the vertical spacing between each control.
Removes all vertical spacing between the controls.
Positions the controls in the center of the view horizontally.
Positions the controls in the center of the view vertically.

Binding to Channels
Binding a control to a channel connects its value or action to the selected channel. Controls can be
bound to the following:
•
•
•

Commands (relays on a remote control or actions performed in AutoPilot for Archer).
Meters
Status (remote control status channels or other site conditions).
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To bind a control, right click on the control and select the type of channel to which you want to bind.

Context menu used to bind channels. Normally, unavailable channel types are grayed out.

Binding Dialogs
To finish binding a channel, use the binding dialog to select the channel (or other data) to which you
want to bind.
Check "Automatically set related properties" if you want the properties for this control to match the
settings for the target channel. For example, if you are binding a graphical meter to a meter channel,
checking this box will set the min and max values and colors to match the configuration of the meter
channel.

This is an example of a binding dialog. The dialog varies based on the type of channel and other selections.
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Customizing Control Properties
Every Custom View control has its own set of properties that you can
use to customize its appearance and behavior. These properties are
displayed in the properties window, docked, by default, to the right
side of the screen.
To adjust a property, simply select it in the grid and enter the desired
value.
Some properties use a drop-down display or popup dialog to support
more advanced editing. Some properties have expand/collapse
buttons to show more/less to expose/hide additional settings related
to a property (such as "Size" and "Location").
A brief description of each property is available at the bottom of the
property grid.
Note: For objects that have a customizable image property, the
image size must be smaller than 3MB.
Map to Key Property
The Click Action group for each Custom View control includes a
property called “Map to Key”. This property makes it possible to
activate the control’s click action by pressing the configured
keyboard key.
Adjusting the Property Grid Display
• The pane at the bottom of the property grid used for the description can be resized to show
more or less of the text.
• The columns of the property grid can be resized by clicking on the vertical dividing line between
them.
• The properties listed in the grid can be sorted alphabetically, or organized by group. Use the
buttons in the property grid tool bar to change the order.
Using PTT Flipbooks
A PTT Flipbook displays the current status and the history of forward power, reflected power and
VSWR (voltage standing wave ratio) for an Archer basestation during times when the associated
basestation PTT signal or synthesized PTT signal is true. Measurements taken during previous PTT
intervals can be displayed by browsing through the earlier pages in the Flipbook.
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Creating a New Flipbook
When a Flipbook is first dragged onto the Custom View canvas from the Meters group, it appears as
shown below.

PTT Flipbook Before Channel Assignment

Select the “Channel Adapter” setting in the Properties Dialog box, and click the button with three dots.
The Chanel Adapter screen appears. Select a “Network”, “Site” and ”Channel” from the drop down . In
the example below the network “Green Mountain”, the site “Green Mountain” and the channel
“Dispatch” have been selected.
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In the Properties Dialog Box double click on “VSWR Chart”. The properties for the VSWR Chart appear.
Click on “Visible” and select “True” from the drop down.

PTT Flipbook Properties Dialog

Close the Custom View Editor. You will be asked to name and save the Custom View.
To open this new Custom View containing the PTT Flipbook, double-click “Custom Views “in the
Resources Window and click on the PTT Flipbook using the name under which the Custom View was
saved.
Because the selected basestation has active history in the AutoPilot log, the historical PTT events are
immediately available for viewing in the PTT Flipbook:

Active PTT Flipbook
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The Flipbook shown above is currently displaying the most recent of 106 previously captured PTT
events. The Oldest, Prev, Next and Newest buttons can be used to navigate among the captured PTT
events. The slider can also be used to move quickly through the database of stored events.
Each captured event can include one or more PTT activations. In this example, the default value of
three seconds is used for the parameter “Break between PTT events”. This means that if the interval
between subsequent PTT activations is less than three seconds, they will be combined into a single
recorded event. The display above shows three PTT activations captured as a single event based on this
setting.
Other settings in the Properties Dialog make it possible to adjust the color, style and weight of each
displayed line of data, and to change the background and foreground display colors. The setting
“Minimum Fwd Power for VSWR or Ref Power” can be used to prevent display of VSWR or reflected
power unless a specified forward power level has been exceeded.
Further visual customization is available by creating a PTT Flipbook (Advanced) control. This control
allows finer adjustments of colors, borders, meter scales and more.
Using Charts
The Custom View Chart control allows you to plot one or more meter channels on a strip chart. Because
the chart control can support multiple lines, using it is different from other metering controls.
Creating a New Chart
Begin by dragging and dropping a chart onto the Custom View canvas, as you would any other control.
To add a meter channel to the chart, click the "Chart Lines" property, found in the "Data" category in
the property grid. Click the [...] button to open the editor dialog.
Select the network, site, and channel for the line you want to add. Click "Save" to add the line to the
chart. You may add as many lines as you like, and can specify the color and style (solid, dotted, etc) for
each line.

The Chart Lines dialog
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The following fields are available for each chart line:
Channel Type
Network
Site
Channel
Label
Color
Line Style
Area Style
Y Axis

The type of channel to be plotted.
The network containing this meter channel.
The site containing this meter channel.
The meter channel you want to plot.
A label to identify the chart line.
The color the chart will use to draw this line.
The style of the line (solid, dotted, etc).
The area fill style to use (solid or none).
The axis (left or right) that this line will use as its Y-axis.

Using the Secondary Y-Axis
If you want to use a single chart to plot channels that use two different units – such as forward power as
a percentage and reflected power in Watts – you can use both the left and right Y-axes. To do so, simply
pick "Left" or "Right" as desired for each line in the Chart Lines dialog.
Adjusting the Y-Axis Range
By default, AutoPilot for Archer will automatically scale the y-axis range to suit the data plotted on the
chart. This range will continue to change over time as new values arrive. If you would prefer to
configure a static range, you may do so using the "Left Y Axis" and "Right Y Axis" properties for the
chart.
First, set the "Auto Scale" property of the axis to "False". Then set the "Minimum Value" and "Maximum
Value" properties to suit your needs.
Adjusting the Time Span
The duration of the chart is configured using the "Duration (sec)" property of the chart. This specifies
the time span represented by the x-axis. Although this property uses seconds, the chart supports
months or even years of data.
Pre-Loading Data and Background Caching
When AutoPilot for Archer first loads a chart, it will use your logged data to pre-load values into the
chart. The amount of data available for this feature depends on your logging settings and the range of
the chart.
When AutoPilot for Archer starts, it will immediately begin "caching" data for your charts, even if they
are not on screen.
Editing and Deleting Custom Views
Editing Existing Custom Views
To edit an existing Custom View, right-click on the Custom View in the AutoPilot for Archer Resources
window or Navigator and select "Edit Custom View...". AutoPilot for Archer will open the Custom View
in the Custom View Editor.
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You can also use the File -> Open dialog in the Custom View Editor to open a Custom View file directly.
Deleting Custom Views
To delete a Custom View, right-click on the Custom View in the AutoPilot for Archer Resources window
and select "Delete". If you delete a Custom View from the Navigator, only that instance of the view is
deleted. To completely remove the Custom View, it must be deleted in the Resources window.
Note: If you delete a Custom View file directly in Windows, AutoPilot for Archer will automatically
remove that Custom View from the Resources window and Navigator.
Using Custom View Templates
Custom View Templates allow you to quickly configure a pre-defined Custom View to work with one of
your sites. A template that resembles the Default View is available.
To create a new Custom View from a template, open the Custom View Editor (File  New Custom
View) and select "New From Template" from the File menu in the editor.
The "Load Template" dialog will prompt you for the following information:
Template
Network
Site
Starting channel

Click the browse button ("...") to locate the template you want to use.
Choose the network containing the site that you want to use for this Custom
View.
Choose the site that you want to use in this Custom View.
Templates are designed to work with a sequential set of channels. For example,
to use channels 17-32 on the selected site, enter "17" as the starting channel.

The Load Template dialog prompts you for the template and site information necessary to configure your new Custom
View.
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Creating Reports
AutoPilot for Archer reports allow you to view and archive site data in a readable, professional format.
Reports can contain data from any number of sites.
When you create a report in AutoPilot for Archer, you are creating a "template" to describe what data a
report should include, and how it should be presented. When you run a report, AutoPilot for Archer
reads the data directly from the onboard database. Once you create a report, you can run it any time
you need to in the future without having to make any edits to update data.
Note: AutoPilot for Archer reports read data from the computer's local database.
Using the Report Wizard
To create a new report using the Report Wizard, select File  New  Report... in AutoPilot for Archer.

Welcome
Click "Next" to start the Wizard.

General
Select the desired page orientation.
Reports can use portrait or landscape
orientation.
Select the desired sort order for your site
data. Data can be sorted in ascending or
descending order.
Check the "Page break for each day"
checkbox if you want each day's data to
begin on a new page.
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Select Database
Select live or archive database, then press
the button with three dots to find the
database in the computer’s file system

Date Range
This page allows you to select the dates
that will be included in the report.
Because AutoPilot for Archer reads from
the database each time you run a report,
it will always use the most current data.
There are several ways AutoPilot for
Archer can filter data by date:
Include all dates
AutoPilot for Archer will use all of your
logged data. This is not recommended if
you have been logging for a long time.
Show data between...
This option allows you to select specific
start and end dates (inclusive) to include
in the report. Because AutoPilot for
Archer will use these exact dates, this is
useful for "one-off" reports, and not
reports that you intend to reuse.
Show data from the last...
This option will use range of dates that
ends today (the day the report is run, not
the day it is created) and begins a certain
amount of time before today. For
example, if you enter "10 Days", the
report will include data starting 10 days
ago and ending today.
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Show data from the prior...
This option uses an even block of time,
ending no later than the day the report is
run. For example, if you enter "1 Week"
the report will include data from last
week. This option is useful for reports that
you intend to run on a regular basis,
where you want the date range to fall on
even boundaries.
Show this ... to date
This option shows the current block of
time (month, week, etc) up through the
current date (the date the report is being
run). For example, if you select "Month"
and run the report on April 20, the report
will show April 1 through April 20.
Select Sites
Place a checkmark in the list next to each
site that you want to include in the report.
You must include at least one site.

Meter Channels
This page allows you to select the meter
channels that you want to include in the
report. Meter channel values are
displayed in columns on the report. For
best results, limit the number of meter
channels you include in your report to
what will fit cleanly on the page. If there is
not enough room for all of your channels,
the report will span multiple pages with
different sets of channels on each page.
To add channels, select the site from the
"Site" drop-down and then select the
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desired channel(s) in the "Channels" list.
Click "Add" to add the selected channel(s),
or click "Add All" to add all channels.
The channels you have selected appear in
the "Selected Channels" list. You can
select channels in this list and click
"Remove" to remove them from the
report, or click "Remove All" to start over.
Use the "Move Up" and "Move Down"
buttons to control the order in which the
channels appear. Your report will use this
order to arrange the meter value columns
across the page.
Status Channels
This page allows you to select the status
channels that you want to include in the
report. There are a couple of different
ways that status channel values may
appear in the report – this is configured on
the next page.
To add channels, select the site from the
"Site" drop-down and then select the
desired channel(s) in the "Channels" list.
Click "Add" to add the selected channel(s),
or click "Add All" to add all channels.
The channels you have selected appear in
the "Selected Channels" list. You can
select channels in this list and click
"Remove" to remove them from the
report, or click "Remove All" to start over.
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Channel Settings
Status
Your report can print status values using
one or both of two methods:
Print status when the status value changes
Status messages will appear in the report
as events. A message will print in the
report showing the new status value and
the time when it changed. Status
channels that remain unchanged will not
print at all.
Print status every time the site is logged
The report will show a line for each status
value for every time when the site was
logged. This works best only when a small
number of status channels are included in
the report.
Meters
Meter readings will appear all on one line
(space permitting) with the exact time (to
the second) of each reading. When a
report comprises multiple sites, this can
cause readings to "stagger" across
multiple lines if the timestamps differ at
all. Use one of the following options to
optimize your report:
Show all meter readings
This is the default choice, and is
recommended for single-site reports.
Show no more than on reading for every ...
minute(s)
This option is recommended when
including more than one site in a report.
Meter readings that happen within the
specified period of time are merged onto
one line. If two sites log at slightly
different times (for example, 1:00:05 and
1:00:42), this will prevent the meter
readings from breaking up into more than
one line on the report.
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Alarms and Events
Select the types of events, alarms, and
alarm severities that you want to include
in the report.

Coloring
Certain kinds of data can be highlighted in
color to help call attention to serious
conditions. "Warning" conditions will
appear in orange, and "critical" conditions
will appear in red.
Use the checkboxes on this page to
specify what kinds of data should use this
coloring feature.

Headers and Footers
If desired, enter a title for your report.
This will appear at the top of the report in
large print.
You may also include page numbers, the
date range of the report, and today's date
(the date you are running the report, not
the date you created it). For each of the
options, you can specify where on the
report/page it will appear.

32

Additional Header/Footer Text
To further customize the report to suit
your needs, you can add additional text to
the top and bottom of each page, the top
of the first page, and the bottom of the
last page. For example, you can a
signature line, contact information,
station details, etc.

Fonts
This page allows the user to select fonts
for specified aspects of the report. Click
the button with three dots to select the
desired font.

Scheduled Printing
You can schedule your report to be
printed or emailed automatically.
For automatic printing, select the printer
you want to use.
For email, enter your email address, or a
list of addresses separated by commas
(engineer@example.com,
gm@example.com).
Select the date and time you want
AutoPilot for Archer to print, and the
frequency with which you want it to
repeat the print job. Each time AutoPilot
for Archer prints this report; it will read
current values from the database.
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Note: When using automatic printing, it is
strongly recommended that you not use a
specific date range, as this would cause an
identical report to print each time.
Finish
Check "Preview this report" if you want to
open a print preview now.
Click Finish to save your report and close
the wizard.

Scheduling Reports
You can schedule reports to automatically print on a regular basis, or have AutoPilot for Archer
automatically send a PDF copy of the report to one or more email addresses.
You can configure the report scheduling options using the Report Wizard, or by right-clicking on a
report in the Resources window and choosing "Schedule Report...".

Report Scheduler dialog
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Viewing, Printing and Emailing Reports

AutoPilot for Archer requires that you have a default printer configured in
Windows, even if you are only using print preview or PDF reports.
Print Preview
You can open a print preview in a separate window or directly in AutoPilot for Archer.
To open a print preview window, select a report from the Resources window or Navigator and click
"Print Preview" from the File menu.
Top open a print preview directly in AutoPilot for Archer, double-click the report's icon in the Navigator.
Note: You can configure AutoPilot for Archer to run a print preview from the Resources window using
a single click by changing the options in the Options dialog.
Saving to PDF
You can save a report to a PDF file by first opening a print preview and then clicking the "Save to PDF..."
button in the tool bar.

"Save to PDF..." in the print preview tool bar.
Print Preview Tool Bar
Prints the report after prompting for a printer.
Print…
Saves the report to a PDF file.
Save to PDF…
Page #
Displays the current page number. Typing a number in this field will jump to
that page.
Moves to the first page of the report.
First Page
Moves to the previous page.
Previous Page
Moves to the next page.
Next Page
Moves to the last page of the report.
Last Page
Size
Displays the relative size of the report (% of full size). Only enabled when not
using the "Auto" feature (see below).
Increases the size of the report.
Zoom In
Decreases the size of the report.
Zoom Out
Auto
When enabled, the report is automatically sized to fit the current window.
Turning this feature off allows you to scale the report manually.
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Note: The report size settings available in the tool bar have no effect on the printed appearance of
the report.
Printing
To print a report, select the report's icon in the Navigator and click "Print..." from the File menu.
To print from a print preview window, use the "Print..." icon from the print preview tool bar (see above).
To print automatically, see

Scheduling Reports.

Emailing Reports
AutoPilot for Archer can automatically email reports to one or more addresses. See
Reports for more information.

Scheduling

In Depth
Program Options
The Options dialog allows you to customize and enable many of the features in AutoPilot for Archer.
Open the Options dialog by clicking "Options" from the Tools menu.

General
Time Synchronization
To have AutoPilot for Archer synchronize the time on
each remote control with the PC's clock, enable Time
Synchronization. Specify the how often you want
AutoPilot for Archer to perform this action.
Note: AutoPilot for Archer will automatically
compensate for any differences in time zone between
the PC and the remote control.
Connections
Wait ... minute(s) between attempts to reconnect
This setting adjusts how long AutoPilot for Archer
waits before attempting to reconnect to a site after a
connection was lost.
Custom View Folder
Allows user to select the default Custom View folder
or browse for a different folder
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Prompt Before Shutting Down
If you enable this feature, AutoPilot for Archer will
display a confirmation dialog when you close the
program, giving you a chance to cancel if you were
closing by mistake.
Resources
Navigator Selections
Open default view after selecting a site in the
Navigator
When checked, AutoPilot for Archer will open the
Default View for a site when you single-click on its
icon in the Navigator.
Open custom view after selecting in the Navigator
When checked, AutoPilot for Archer will open a
Custom View when you single-click on its icon in the
Navigator.
Open print preview after selecting a report in the
Navigator
When checked, AutoPilot for Archer will
automatically generate and display a print preview
for a report when you single-click on its icon in the
Navigator.
Always Open Custom Views in a New Window
When checked, all custom views will open in their
own window, rather than in the main AutoPilot for
Archer window.
Custom Views in a New Window are Full Screen
When enabled, AutoPilot for Archer opens Custom
Views in a New Window in full-screen mode.
Open a Custom View on Startup
When enabled, AutoPilot for Archer will open the
selected Custom View when the program starts. This
is most commonly used for map or overview displays
employed by network operation centers.
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Alarm Notification
For more information on alarm notifications, see
Alarm Notifications.
Alarm Sound
Enable this feature if you want AutoPilot for Archer
to play a sound file when it receives a new alarm from
any site.
Optionally, AutoPilot for Archer can loop the sound
file. You can specify how long to wait (in
milliseconds) between each iteration of the loop, and
can have AutoPilot for Archer stop looping the sound
after a certain number of minutes.
Email Notifications
Enable this feature if you want AutoPilot for Archer
to send an email to the specified address or
addresses when a new alarm is received.
To enter a list of addresses, separate each address
with a comma (,) or semicolon (;).
Note: This feature requires correct setup of email
settings.
Show New Alarms Dialog
When enabled, AutoPilot for Archer will open the
New Alarms dialog when a new alarm is received.
Show Desktop Alert
When enabled, AutoPilot for Archer will show a
"desktop alert" when a new alarm is received. The
desktop alert displays in the lower right corner of the
screen, and fades away after a few seconds. This is a
useful way to display alarm notifications without
interrupting the operator.
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Logging
Log hidden channels
When enabled, AutoPilot for Archer will log channels
even if they are hidden. Otherwise, AutoPilot for
Archer will not log data for hidden channels.
Take a log after a critical alarm
When enabled, AutoPilot for Archer will take a
telemetry snapshot after it receives a critical alarm.
Take a log after a warning alarm
When enabled, AutoPilot for Archer will take a
telemetry snapshot after it receives a warning alarm.
Wait ... seconds after the alarm before logging
Specifies the number of seconds AutoPilot for Archer
will wait before taking a telemetry snapshot after
receiving an alarm.
Wait ... minutes before retrying a log if unable to take a
log
Specifies the number of minutes AutoPilot for Archer
will wait before retrying to take a log on a site when
the previous attempt was unsuccessful.
Use default Log location
Allows user to select default location for log or
browse for a different location
Available Drives
Advises the user on the amount of space available on
accessible drives
Note: AutoPilot for Archer will always log the alarm.
The settings in this section only affect telemetry
logging when alarms occur.
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Security
Password protect AutoPilot for Archer configuration
When checked, AutoPilot for Archer will require a
password to unlock configuration settings. For more
information, see Security.
Require ctrl+click to issue commands on default views
When checked, AutoPilot for Archer will not issue a
command from a Default View unless you hold down
the Control key on the keyboard while clicking.
AutoPilot for Archer will display a prompt if you click
on a command without holding the Control key.
Note: Requiring ctrl+click on Default Views does not
affect Custom Views. However, each Custom View
command can be configured to require ctrl+click in the
Custom View Editor.
Email
Email settings are required if you plan to use any of
the email features in AutoPilot for Archer, such as
emailing PDF reports.
If you are unsure of your email settings, consult your
network administrator or Internet Service Provider.
SMTP server
Enter the IP address or host name of your email
server.
Port
The port number used by your SMTP server. This is
typically 25.
From address
AutoPilot for Archer will use this for the "from
address" field in email messages. This setting is not
critical, but may affect how a spam filter treats
messages sent by the software.
Use authentication
Check this box if your SMTP server requires a user
name and password, and enter those values in the
fields beneath the checkbox.
Use STARTTLS
Check this box to use STARTTLS. A user name and
password will be required.
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Licensing
To add license keys for AutoPilot for Archer add-ons, or to use a demo key, access the Licensing dialog
from the Help menu.
Note: The Licensing dialog is only used for add-ons and demos. You do not need to enter your remote
control's authorization code in this dialog.

Licensing Dialog

To add a new license, click New License. AutoPilot for Archer will prompt you for your company name
and license key.
After you enter a license key it will take effect immediately (you do not need to restart the software).
Note: Each license key you add to AutoPilot for Archer must be for the same company name.
Although it is not normally necessary to remove a license key, you can do so by selecting the license
from the list and clicking the Delete button.
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Connectivity
Connecting and Disconnecting
To connect to, or disconnect from, any site, select its icon in the Resources window or Navigator and
use the appropriate option from the File menu, tool bar, or context menu (accessed by right-clicking on
the site icon). These options are explained below:
Connect
Connect As…
Disconnect

AutoPilot for Archer will connect using the primary connection settings.
AutoPilot for Archer will prompt you for connection settings and a user
name and password before connecting.
AutoPilot for Archer will disconnect from the site. AutoPilot for Archer will
not restore this connection after you manually disconnect.

Note: If you have configured a site to not save the password, AutoPilot for Archer will always prompt
for a password when connecting to that site.
Connection Details Dialog
The Connection Details dialog shows connection statistics and other data about your sites. To access
this dialog, select a site in the Resources window or Navigator and click "Connection Details" from the
File menu.

Connection Details
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The Connection Details dialog shows the following parameters.
Connection Details
Connected via
Connected since

Connection Statistics
Data Sent
Total bytes
Total packets
MS since last

Data Received
Total bytes
Total packets
Bad bytes
Bad packets
MS since last

The IP address or host name plus TCP port, COM port, or modem name and
phone number used to connect to this site.
The date and time the connection was established.

The total number of bytes sent from AutoPilot for Archer to the site.
The total number of packets sent from AutoPilot for Archer to the site.
The number of milliseconds since AutoPilot for Archer last sent a packet to
the site.

The total number of bytes sent from the site to AutoPilot for Archer.
The total number of packets sent from the site to AutoPilot for Archer.
The number of bytes received from the site that AutoPilot for Archer could
not parse into a valid packet.
The number of packets received from the site that AutoPilot for Archer
could not interpret as valid.
The number of milliseconds since AutoPilot for Archer last received a valid
packet from the site

Site Configuration Cache
AutoPilot for Archer saves a copy of your Archer site configuration files in its onboard cache. This allows
AutoPilot for Archer to avoid downloading site configuration when it already has the current files.
Although it is never necessary to do so, you can clear these cache files by selecting "Clear Saved Site
Configuration" from the File menu.
Note: After clearing the site configuration cache, you must restart AutoPilot for Archer before your
Archer site will respond to this change.
Sync Configuration
You can update AutoPilot for Archer’s cached configuration by right-clicking on a site in the Resources
window or Navigator and selecting “Sync Configuration”
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Backup Connections and Automatic Reconnection
AutoPilot for Archer has several built-in options to help you stay connected to your sites 24x7.
Terminology
Primary Connection
Automatic Connection

Connection Recovery

Retrying a Connection

Manual Connection
Manual Disconnection

Your primary connection to a site is the connection that you consider
"normal", and will use in most cases.
A connection is automatic when AutoPilot for Archer connected without
requiring a user interaction. When a site is configured to connect at
startup, AutoPilot for Archer will automatically connect to it when the
program starts.
When a connection is lost, AutoPilot for Archer will first attempt to
recover it. AutoPilot for Archer does this immediately after a connection
loss. If the connection is recovered successfully, AutoPilot for Archer will
not note a warning in the Application Event List.
Except under certain circumstances (explained below), AutoPilot for
Archer will retry a connection periodically after a connection loss. This
happens only after connection recovery is unsuccessful (see above).
Whenever you connect to a site by clicking one of the connect icons, you
are connecting manually.
Whenever you disconnect from a site by clicking the disconnect icon,
you are disconnecting manually.

Automatically Reconnecting after a Connection is Dropped
AutoPilot for Archer will automatically reconnect to a site after a connection is lost. There are two
phases to this process:
1. AutoPilot for Archer will attempt to recover the connection immediately. If this is successful,
AutoPilot for Archer will not log a warning in the Application Event List.
2. AutoPilot for Archer will periodically retry the connection. The timing of this process is
adjustable using the Options dialog.
Note: If a connection recovery is unsuccessful, AutoPilot for Archer will log a warning in the
Application Event List. AutoPilot for Archer will not log additional warnings if reconnection attempts
are unsuccessful, as this would "flood" the log over a period of time.
If a connection is restored but then lost again, AutoPilot for Archer will log a warning again.
AutoPilot for Archer will not reconnect to a site under the following circumstances:
•
•
•

You manually disconnected from a site.
You connected to a site using "Connect As...".
Your site is configured to prompt for a password.
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Alarm Management
Site Alarm List
To view alarms from a single site only, right-click on the site's icon in the Resources window or
Navigator and select "Site Alarms".
The site alarm list displays all the uncleared alarms for the selected site.

Site Alarm List

Notifications and Sounds
AutoPilot for Archer can notify you of new alarms in several ways, described below:
Alarm List
The Alarm List is the main place where AutoPilot for Archer displays information about alarms. New
alarms are differentiated by their icon.
For more information on the Alarm List, see Alarms Overview.

Alarm List
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New Alarms Dialog
The New Alarms dialog, enabled using the Options dialog, will pop up whenever a new alarm occurs.

New Alarm Dialog

If there is more than one new alarm, the New Alarms dialog will show all of the new alarms.
Clicking on an alarm in the list will display more information about the alarm at the top of the dialog.
Clicking "Clear" will clear the selected alarm.
New Alarm Desktop Alert
A "desktop alert" is a small notification that appears in the lower right corner of the screen. The
notification will automatically disappear after a few seconds. This kind of notification is a useful way to
make an operator aware of new alarm condition with causing an interruption.

New Alarm Desktop Alert

Hovering over the desktop alert will prevent it from closing.
Clicking the "Clear Alarm" icon (

) in the lower left corner of the alert will clear the alarm.

Sounds
If desired, AutoPilot for Archer can play a sound when a new alarm is received. This option is configured
in the Options dialog.
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Logging
AutoPilot for Archer logs the following types of data:
•
•
•
•

Telemetry (meter and status readings)
Status changes
Alarms
Events

Enabling Logging
AutoPilot for Archer will always log alarms and events for all sites. Telemetry logging is enabled
individually for each site, and can be enabled/disabled for the entire application.
When logging for the application is disabled, AutoPilot for Archer will not log telemetry on any sites.
When enabled, AutoPilot for Archer will log telemetry on all sites for which logging is enabled at the
site level.
To enable logging for AutoPilot for Archer, click "Enable Logging" from the Tools menu.
To adjust logging settings for a site, right-click on the site's icon in the Resources window or Navigator
and select "Configure Logging...".

Logging Configuration Dialog

Logging and Connections
If you are not connected to a site that is due to be logged, AutoPilot for Archer will automatically
connect to the site for you. When AutoPilot for Archer is finished logging the site, it will automatically
disconnect.
Note: Logging will never cause AutoPilot for Archer to disconnect from a site that was already
connected.
Logging on Demand
To force AutoPilot for Archer to immediately take a log, click "Log Now" from the tools menu.
Note: You must already be connected to a site to use the "Log Now" feature.
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Onboard Database
AutoPilot for Archer stores its logs and captures in the onboard database. For more information on
exporting and archiving your logged data, see Data Management.
The onboard log uses aa SQLite Database. When AutoPilot for Archer starts up, it will create this file
automatically if it does not already exist.
The onboard database file is located here:
Windows Windows 7 through 10 search for:
%AllUsersProfile%\Burk Technology\AutoPilot for Archer\Databases\Log.db
Or navigate to: C:\ProgramData\Burk Technology\AutoPilot for Archer\Databases\Log.db

While it is possible to open this file using a third party SQLite browser, it
is strongly recommended that you instead export your data or use Text
File Logging.

Never open this file while AutoPilot for Archer is
running.
Data Management
Exporting Data
AutoPilot for Archer has a built-in export feature that allows you to export your logged data in a variety
of different formats, each suitable for analysis in 3rd party applications.
To export your data, click "Export Logged Data..." in the Tools menu.
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Export dialog

The following options are available on the Export dialog:
Format

Data
Network
Site
Start date
End date
Convert times
to local time
zone

AutoPilot for Archer supports the following formats: Excel, CSV (comma
separated values), Tab (tab delimited values), and XML (extensible markup
language).
Select the database table that you want to export: Telemetry, Alarms, Events, or
Status Changes.
Choose the network whose data you want to export, or choose "All Networks".
Choose the site whose data you want to export, or choose "All Sites"
Check the "Start date" checkbox and select a date if you want to export data only
from dates on or after the selected date.
Check the "End date" checkbox and select a date if you want to export data only
from dates on or before the selected date.
When this option is checked, AutoPilot for Archer will convert all timestamps to
use the local time zone instead of UTC.

Note: Exporting data does not remove it from the database.
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Archiving Data
Over time and depending on the number of sites you have added to AutoPilot for Archer, your onboard
database may grow very large. Archiving data will remove it from the database and store in an archive
file that you can access later.
While the technical limit to the size of the database is 2GB, it is highly
recommended that you periodically archive your data to optimize
performance.

To archive your data, click "Archive Logged Data..." in the Tools menu.

Archive Data dialog

Enter the date that you want to use to archive your data. Any data older than this date will be removed
from the database and stored in the archive.
Archived data is stored in XML format. AutoPilot for Archer will prompt you for the location where you
want to store this file.

Security
Security Overview
Password Encryption
There are several places throughout AutoPilot for Archer where the software will prompt you for a
password. AutoPilot for Archer never stores your passwords in "plain text". Passwords are encrypted
using standard encryption methods whenever it is necessary to save to a file.
Remote Control Permissions
Your remote control has built-in security mechanisms, varying by model. Remote control security
prevents unauthorized users from reading your data or issuing commands.
Maintenance Mode
Your remote control also has a "maintenance mode" or "remote/local" mode feature. This feature locks
out remote commands for safety reasons during maintenance operations. The remote control will not
permit AutoPilot for Archer to issue commands when in maintenance mode.
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Note: AutoPilot for Archer will gray out commands that are unavailable due to insufficient
permissions or maintenance mode.
Even if a command were to appear available, the remote control itself would not allow AutoPilot for
Archer to issue the command.
Locking AutoPilot for Archer Configuration
If desired, you can password protect AutoPilot for Archer's configuration options. This is useful to
prevent operators from making undesired changes.
To enable this feature, use the "Security" tab in the Options dialog.
Once you have enabled password protection and set a password, click "Lock AutoPilot for Archer
Configuration" in the File menu to lock or unlock the configuration.

Unlock Configuration password prompt

Application Event List
AutoPilot for Archer logs various activities using the Windows Application Event Log. While you can
access this log directly in Windows, AutoPilot for Archer makes it available in the program as well.
To access the Application Event List, click "Application Event List" from the View menu.

Application Event List
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To see more information about an event, double-click on its entry in the event list.

Application Event details

Note: The Application Event dialog includes a "Copy" button that will copy the event details to the
clipboard. You can then paste this information into a file or email.
There are three types of events logged in the list:
Information

Warning
Error

Information events are a record of some of the regular operations that AutoPilot
for Archer performs. These events are normal, and do not indicate any kind of a
problem.
Warning events indicate that an operation was unsuccessful, due to foreseeable
circumstances (such as a connection loss).
An error condition is an abnormal failure. Under normal circumstances, error
conditions should never occur.

Note: AutoPilot for Archer will notify you of new Error conditions by showing an icon in the Status
Bar.

Migration
Migrating your AutoPilot for Archer installation from one computer to another – or cloning your
configuration for use on second PC – is relatively easy. All of your files are stored in one folder on the
computer:
Windows Vista and Windows 7 through 10, search for:
%AllUsersProfile%\Burk Technology\AutoPilot for Archer
Or navigate to: C:\ProgramData\Burk Technology\AutoPilot for Archer

To completely clone your installation onto another computer, simply copy the files from this folder
onto the new computer. If desired, you may copy only certain files. See below for more information.
You must still install AutoPilot for Archer on your new computer. Copying
this folder does not install the software for you.
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AutoPilot for Archer Files and Folders
Folders
Cache
The cache folder stores local copies of your site configuration. These files can be
safely deleted or omitted during data migration.
Custom Views
This folder contains all of your Custom View files
Databases
This folder contains your onboard logging and captures database (Log.db). If you
delete or omit this file, AutoPilot for Archer will create a new one on startup.
Licensing
This folder contains your licensing information for add-ons and demos.
Reports
This folder contains your report files.
Settings
This folder contains various files that store settings, sites, etc. See below for more
details.

Network Names
If you plan to share Custom Views or other site-related data between multiple computers, it is
important that you use the same network name on each computer for your sites. AutoPilot for
Archer uses the network name to identify your sites.
Note: You can rename a network within AutoPilot for Archer. AutoPilot for Archer will display a
prompt asking if you want to update your Custom Views, etc.
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Reference
Custom Views
Controls
Command Buttons
Command Button
A standard command button.

LED Button
A command button with an embedded LED.

LED Button (2 Lines Centered)
A commands button with an embedded LED and a 2 line centered caption label.

LED Button (2 Lines)
A commands button with an embedded LED and a 2 line caption label.

Sticky Button
The Sticky Button remains "stuck" down when its status condition is "ON". This control works best when
used in mutually exclusive pairs.
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General
Camera Picture
Embeds a web cam picture in your Custom View. Works with Panasonic web cams.

Clock
A simple clock with adjustable time zone offset.

Custom View Extents
Set the aspect ratio for auto scaling of custom views.

Label
A basic, general purpose label control.

Line
Draws a straight line.
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Map
A resizable map. State maps are available, as well as a map of the US.

Picture
Embeds an image in your custom view. The image is saved with your Custom View, and will work even
if the view is loaded on another computer.
Text File
Shows the contents of any text file on your computer.

Weather Map
A weather map from the National Weather Service. Can be displayed as a static image or animation.
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Web Page
The Web Page control allows you to embed a web page directly in your Custom View.

Web Picture
Embeds any image from a web site. Can be set to periodically refresh.
Meters
Angular Meter
A classic gauge.

Angular Meter (Advanced)
A classic gauge with additional Labels and Meter properties.

Bar Meter
Displays a meter on a linear meter that fills in with color to indicate value.
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Chart
A strip chart control that supports multiple lines. See Using Charts for more information.

Compass
Use the compass control to display direction.

Linear Meter
Displays a meter value on a linear indicator. Can be oriented horizontally or vertically.

Nominal Bar
The nominal bar displays a meter value relative to a specified nominal value. This allows an operator to
quickly determine what parameters are out of tolerance.
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Power Meter
Displays power using W (or kW) and dBm.

Right Angle Meter
A gauge-style meter starting on the left and spanning 90°.

Text Meter
A simple non-graphical meter display.

Thermometer
Displays temperature values.
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Trend Arrow
Indicates whether a meter channel is trending up or down, or is steady.

VSWR Meter
The VSWR meter automatically calculates VSWR using forward and reflected power.

PTT Flipbook
A PTT Flipbook displays forward power, reflected power and VSWR for an Archer basestation. See
Using PTT Flipbooks for more information.

Shapes
Rectangle
A rectangle or square.
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Oval
An oval or circle.

Specialized
Summary Site Status and Summary Group Status Controls
The Summary Site Status and Summary Group Status controls make it possible to display a summary of
alarm conditions for a single site, in a single graphical element. These graphical elements use a color
grid of consisting of one to four colors, depending on the type of alarms associated with the group. The
four color categories are as follows:
•
•
•
•

Green – No critical or warning alarms
Yellow – Warning alarms
Red – Critical alarms
Grey – Site is not communicating with AutoPilot for Archer

Sites
The Summary Site Status control shows the name of the site and a color bar that represents one of five
states, as described in the following table. If the site has critical or warning alarms, the total number of
alarms is shown in the red or yellow box.
Green – Site is connected with no
critical alarms or warnings.

Grey— Site is not communicating
with AutoPilot for Archer.

Yellow – Site has warning alarms.
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Red – Site has critical alarms.

Split red/yellow – Site has critical
alarms and warnings. In this
example, the site has 7 critical
alarm and 2 warnings.

Groups
The Summary Group Status control shows the group name on the top line. Below the text, a color bar
represents the group states along with the number of sites in a group (in cases where a single number
appears). For alarms, (yellow and red), the number of alarms appears, followed by the number of sites
that are reporting the alarms.
To get detailed information on a group, click its control.
Green – All sites are
communicating, with no alarms
or warnings.
Grey— None of the sites in the
group are communicating with
AutoPilot for Archer.
Yellow – At least one site in the
group has one or more warning
alarms. In this example, three
alarms are occurring at one site.
Red – At least one site in the
group has one or more critical
alarms. In this example, a total of
four critical alarms are occurring
at two sites.
Red/Yellow – At least one site in
the group has one or more critical
alarms and at least one site has
one or more warning alarms. In
this example, one site is reporting
a critical alarm and three warning
alarms are occurring among two
sites.
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When some of the sites in the group are not communicating with AutoPilot for Archer, the right-most
(grey) column displays the number of sites that are not communicating. The two-left columns display
green, red and yellow columns, as described in the previous table.

In this example, the following conditions exist:
•
•
•

Three sites (grey) are not communicating with AutoPilot for Archer
One site (red) is reporting a critical error.
Three warning errors are occurring between two sites (yellow).

To add a Summary Site Status or Summary Group Status control, drag one of the following items from
the Specialized list in the Custom View Editor.

In the Properties panel, click on the three-dot icon next to Channel Adaptor .

Select a Channel Adaptor to link the control to a Site or a Group.
To link to a Site, select the Network that contains the Site and the Site you want to link to this control.
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To link to a Group, select a Node from the list.

If you check “Automatically set related properties”, the site or group name will automatically populate
based on the selected item. In the Properties panel, you can specify additional settings that define the
appearance of the Summary Site Status or Summary Group Status control (such as color mapping for
alarm levels, caption text, etc.) or you can accept the default settings.
Status
Arrow LED
Displays an arrow pointing up, down, left, or right.
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Diamond LED
A diamond-shaped LED.

Label LED
A rectangular LED that includes a caption. The caption changes based on the status condition.

Label LED (2 Lines Centered)
A rectangular LED that includes a 2 line caption centered on the object. The caption changes based on
the status condition.

Label LED (2 Lines)
A rectangular LED that includes a 2 line caption. The caption changes based on the status condition.

Rectangular LED
A rectangular LED.

Round LED
A basic, round LED.

Status Label
The status label control displays different labels for "ON" and "OFF".
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Status Line
A line that changes color based on the status condition.

Status Panel
The status panel is used to provide a background that changes color based on status for part or all of
your Custom View
Status Picture
The status picture shows one picture when "ON" and another picture when "OFF".
Status Sound
The status sound plays a sound file based on a status condition, as long as the Custom View hosting the
control is on screen.
The status sound control does not appear on your Custom View, except in the Custom View Editor.
.Status Conditions
Available status conditions for the Channel Adapter property of status custom view objects.
Status Channel
Raise Relay Active
Lower Relay Active
Macro Running
Meter Below Low Critical
Meter Below Low Warning
Meter Above High Warning
Meter Above High Critical
Meter Out of Tolerance
Site in Alarm
Network in Alarm
Site Connected
Site in Maintenance Mode
Active Flowchart Running
Virtual Channel
Any Network in Alarm
Site Connected On Primary
Site Connected On Backup

A status channel on a remote control unit.
"ON" when the specified raise relay is engaged.
"ON" when the specified lower relay is engaged.
"ON" when the specified macro is running.
"ON" when the specified meter is below the second lower limit.
"ON" when the specified meter is below the first lower limit.
"ON" when the specified meter is above the first upper limit.
"ON" when the specified meter is above the second upper limit.
"ON" when a meter is outside of its "normal" range (above either
upper limit or below either lower limit).
"ON" when the specified site has at least on uncleared alarm.
"ON" when any site in the specified network has at least one
uncleared alarm.
"ON" when the specified site is connected to AutoPilot.
"ON" when the specified site is in maintenance mode (or "Local" mode
on a GSC3000 or VRC2500).
“ON” when the specified Jet Active Flowchart is running.
“ON” when the specified virtual channel evaluates to true.
“ON” when any connected site on any network has an alarm
condition.
“ON” when the specified site is connected over the primary
connection.
“ON” when the specified site is connected over the backup
connection.
66

Actions
Available actions for custom view objects with a command adapter property.
Raise
Lower
Navigate
Run Macro
Stop Macro
Clear Alarms
Connect
Disconnect
Run Application
Open URL
Print Report
Ping
Navigate (New Window)
Show Default View
Show Default View (New
Window)
Run Active Flowchart
Stop Active Flowchart

Issues the specified raise command.
Issues the specified lower command.
Opens the specified Custom View in the current window.
Starts the specified macro.
Stops the specified macro.
Clears alarms on the specified site or network.
Connects to the specified site using the primary connection.
Disconnects from the specified site.
Runs the specified command in Windows to launch an
application.
Opens a web browser with the specified URL.
Prints the specified report using the default printer.
Pings the specified Network Device.
Opens the specified Custom View in a new window.
Opens the Default View for the specified site in the current
window.
Opens the Default View for the specified site in a new window.
Runs the specified Jet Active Flowchart.
Stops the specified Jet Active Flowchart.

Database Schema
Directly accessing the onboard database is not recommended.
Tables
The following tables are included in the database:
Table Name
Alarms
Events
StatusChanges
Telemetry

Description
Stores alarms.
Stores events.
Stores a record for each time a status channel changed.
Stores a snapshot of meter and status channels for each time AutoPilot for
Archer takes a log.
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Alarms
Field
UTCDateTime
NetworkName
UnitName
UnitID
AlarmTypeID

Data Type
Date/Time
String
String
Integer
Integer

AlarmSeverityID Integer

ChannelNumber

Integer

ChannelName

String

AlarmMessage
TimeZoneOffset
AlarmClass

String
Integer
Integer

SourceIndex

Integer

UTCInactiveTime Date/Time
Disposition

Priority

Integer

Byte

Description
The date and time of the alarm using UTC time.
The name of the network on which the alarm occurred.
The name of the site on which the alarm occurred.
The unique ID identifying the remote control unit.
Indicates what type of alarm this is:
0
High Limit
1
Low Limit
2
Status
3
System
4
User
Indicates the severity of the alarm:
-1 Normal
0
Warning
1
Critical
The channel number on which this alarm occurred. This value is
0 for non-channelized alarms.
The label of the channel on which this alarm occurred. This value
is blank for non-channelized alarms.
The message associated with the alarm.
The time zone offset (number of minutes from UTC) for this site.
Describes the type of source for the alarm. Used internally by
AutoPilot for Archer.
Used along with the Alarm Class to uniquely identify the alarm.
Used internally by AutoPilot for Archer.
The time (UTC) when the alarm became inactive. Not applicable
for incidental alarms or active alarms.
The current disposition of the alarm:
0
Incidental
1
Active
2
Inactive
The user-defined priority of this alarm. A value of 0 is used when
no priority is set.
Note: A value of 1 may be either the highest or lowest priority.
Within AutoPilot for Archer, this value is only used for sorting
purposes and does not otherwise impact functionality.
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Events
Field
UTCDateTime
NetworkName
UnitName
UnitID
EventTypeID

Data Type
Date/Time
String
String
Integer
Integer

Description
The date and time of the event using UTC time.
The name of the network on which the event occurred.
The name of the site on which the event occurred.
The unique ID identifying the remote control unit.
Describes the type of event. Used internally by AutoPilot for
Archer.
Note: The values available for this field are numerous and subject
to change.

EventMessage
TimeZoneOffset
Status Changes
Field
UTCDateTime
NetworkName
UnitName
UnitID
ChannelNumber
StatusValue
StatusMessage
StatusStateID

TimeZoneOffset

String
Integer

Using the field is not recommended.
Describes the event.
The time zone offset (number of minutes from UTC) for this site.

Data Type
Date/Time
String
String
Integer
Integer
Boolean
String
Integer

Description
The date and time of the status change using UTC time.
The name of the network on which the status change occurred.
The name of the site on which the status change occurred.
The unique ID identifying the remote control unit.
The channel number whose status changed.
The value of the status channel after the change.
The status label associated with the new value.
The alarm state of the status channel:

Integer

-1 Normal
0 Warning
1 Critical
The time zone offset (number of minutes from UTC) for this site.
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Telemetry
Field
UTCDateTime
NetworkName
UnitName
UnitID
ChannelNumber
ChannelName
MeterValue
Units
AnalogStateID

StatusValue
StatusMessage
StatusStateID

TimeZoneOffset

Data Type
Date/Time
String
String
Integer
Integer
String
Single
String
Integer

Description
The date and time of the snapshot using UTC time.
The name of the network on which the snapshot occurred.
The name of the site on which the snapshot occurred.
The unique ID identifying the remote control unit.
The channel number included in this snapshot.
The meter label for this channel.
The calibrated value of the meter channel.
The units label for the meter channel.
The alarm state of this meter channel:

Boolean
String
Integer

-1 Normal
0 Warning
1 Critical
The value of the status channel.
The status label associated with the status value.
The alarm state of the status channel:

Integer

-1 Normal
0 Warning
1 Critical
The time zone offset (number of minutes from UTC) for this site.
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